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Preface
Overview

Welcome to Installing Rational RequisitePro. This document provides the information 
you need to install RequisitePro, configure enterprise databases for RequisitePro 
projects, and configure your Web server for RequisiteWeb. 

Rational RequisitePro, the premier requirements management tool, integrates a 
powerful multi-user requirements database utility with the familiar environment of 
Microsoft Word for Windows, enabling you to simultaneously work with a 
requirements database and requirements documents. 

The Rational Software Setup program lets you perform standard and custom 
installations of RequisitePro. The common install procedure allows you to install 
enterprise database configuration scripts, RequisiteWeb components, and related 
documentation. 

This manual provides you with:

� Information needed to perform a typical installation of RequisitePro and 
RequisiteWeb. 

� Information needed to remove RequisitePro and RequisiteWeb from your system. 

� Instructions for configuring Oracle and Microsoft SQL Server databases for 
RequisitePro projects.

� Instructions for installing RequisiteWeb server components on an IIS Web  
server.

� Notes on configuring the Rational E-mail Reader for use with RequisitePro 
projects.

Audience

This guide is intended for anyone who is installing RequisitePro and its related 
components. It assumes a basic knowledge of Microsoft Windows and its 
conventions. Enterprise database configuration requires the support of a database 
xi



administrator. To install and configure RequisiteWeb, you should be familiar with the 
selected platform and Web server.

Other Resources

� The release notes appear at the end of the RequisitePro installation. They are 
available from a link in the Let’s Go RequisitePro application, which appears 
when you first launch RequisitePro. They are also available on the Start menu in 
the Rational RequisitePro program group. You must have a Web browser to view 
the release notes. 

� The Administering Licenses for Rational Software manual, included with your 
installation materials, describes the Web-based license manager AccountLink, the 
Rational License Key Administrator, and the Rational software licensing model. 
This manual also provides instructions and troubleshooting information for 
acquiring, installing, and configuring licenses. You must install license keys to use 
Rational products; you can install them before or after you install the products. 

� The guide Using Rational RequisitePro and other Rational product 
documentation is included on a separate CD: Rational Solutions for Windows – 
Online Documentation CD. Rational online manuals are presented in PDF format. To 
read PDF files, you must install Adobe Acrobat Reader, available from the Adobe 
Web site, http://www.adobe.com/, or on the Rational Solutions for Windows CD in 
the extras directory.

� Online Help. You can view online help within RequisitePro whenever 
you need assistance. To display the Help Contents, click the Help 
button on the Tool Palette; on the Help menu, click Contents and 
Index; or press the F1 key. You can also click the Help button in any 
dialog box.

� For information on integrating RequisitePro with Rational Rose and Rational 
ClearQuest, refer to the manuals Getting Started with Rational Suite 
AnalystStudio and Configuring Rational Suite on the Rational Solutions for 
Windows – Online Documentation CD. 

� For more detail on the Rational Software Setup program, including information on 
implementing a silent installation, refer to the manual Installing Rational Suite on 
the Rational Solutions for Windows – Online Documentation CD. 

� Rational Training Services. For more information on training opportunities, see 
the Rational University Web site: http://www.rational.com/university.
xii Preface
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Rational RequisitePro Documentation Roadmap
Rational RequisitePro Documentation Roadmap xiii



Contacting Rational Technical Publications

To send feedback about documentation for Rational products, please send e-mail to 
our technical publications department at techpubs@rational.com.

Contacting Rational Technical Support

If you have questions about installing, using, or maintaining this product, contact 
Rational Technical Support as follows:

Please help our Technical Support staff deliver quality customer service by providing 
complete information. The techsupport.html file, which is located in the RequisitePro 
installation directory and is also available by clicking Help > Contacting Technical 
Support, contains a Customer Information Form. You can use this form to document 
problems, questions, or suggestions and to detail your company and system 
information. The form can be copied into your e-mail message.

Attach your error.log file (located in the RequisitePro installation directory in the bin 
folder) if you are getting an error message. Add any files, screen captures, and other 
information you feel are relevant.

Table 1 Rational Technical Support Information

Location Contact Information Notes

U.S. and Canada 800-433-5444

781-676-2450

support@rational.com

When sending e-mail:
� Specify the product name in the 

subject line, for example, 
“RequisitePro”. 

� For existing issues, include your case 
ID in the subject line.

Europe +31 (0) 20 4546 200

support@europe.rational.com

Asia Pacific +61-2-9419-0111

support@apac.rational.com

World Wide Web http://www.rational.com Click the Technical Support link. 
xiv Preface
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Licensing Support

Table 2 provides Rational License Support contact information. If you have questions 
about acquiring license keys for your Rational Software products, contact Rational 
License Support. See the online help in the Rational License Key Administrator for 
additional licensing support information.

Other Contacts

Joining the RequisitePro Users Mailing List 

Rational has created an open e-mail list “req_forum@rational.com” for customers to 
exchange ideas on using RequisitePro. This list is monitored to ensure that product 
questions and problems are being answered. To subscribe to the mailing list, go to the 
following Web site: http://www.rational.com/support/usergroups.

Table 2 Rational Licensing Support

 Region Telephone E-mail

North and South 
America 

1-800-728-1212

1-781-676-2510

FAX: 781-676-2510

lic_americas@rational.com

Europe
(includes Israel 
and Africa)

Phone: +31 20 4546 200

Fax: +31 20 4546 202

lic_europe@rational.com

Asia Pacific Phone: +61-2-9419-0111
FAX: +61-2-9419-0123

lic_japan@rational.com
(Japanese)

lic_apac@rational.com
(English only)
Other Contacts xv
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1Before You Install
This chapter presents system requirements and general guidelines to help you 
prepare for installing or upgrading Rational RequisitePro. This chapter includes the 
following topics:

� System and Software Requirements on page 2

� Administrator Privileges on page 3

� Installing Multiple Rational Products on page 3

� General Requirements on page 4

� Installation Types on page 5

� Installing Shared Files on page 5

� Upgrading Rational RequisitePro on page 7

� Silent Installations on page 7
1



System and Software Requirements

Table 3 describes the system and software requirements for installing the RequisitePro 
client. 

*Recommendations for Microsoft Office:
� with Windows NT, use Office 97 SR2 or Office 2000;
� with Windows 98, Windows ME, and Windows 2000, use Office 2000.

Table 3 RequisitePro Client Requirements

Item Requirement

Operating Systems One of the following:
� Microsoft Windows 2000 Professional Service Pack 1
� Microsoft Windows 98 Second Edition
� Microsoft Windows NT 4.0 Workstation Service Pack 6a
� Microsoft Windows Millennium Edition

Processor 200 MHz or greater; 300 MHz or higher is recommended

Memory 64 MB or greater; 128 MB is recommended. For UCM, 256 MB is 
recommended for RequisitePro project administrators.

Disk Space 100 MB

Monitor 800 X 600 X 256-color video resolution, or greater; 
High Color or True Color recommended

Mouse/pointing 
device 

Microsoft Mouse or compatible pointing device

Word Processor Microsoft Word 97 Service Release 2 or Word 2000 Service Release 1*

Requirement Metrics 
Reporting

Microsoft Excel 97 Service Release 2 or Excel 2000 Service Release 1*

Browser Microsoft Internet Explorer 4.0 Service Pack 1 or later* 
(Required for RequisitePro operation. For RequisiteWeb requirements, 
see RequisiteWeb System Requirements on page 38.)

LAN Support Microsoft networks

Automated License 
Key Requests

Internet connection required for automated license requests

Oracle Client Versions 7.3.4, 8.0.5, 8.1.5, 8.1.6
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Table 4 describes the system and software requirements for installing an enterprise 
database for RequisitePro. 

Administrator Privileges

To use the Rational Software Setup program on a Windows NT or 2000 system, you 
must have Windows NT or 2000 administrator privileges on the local system. Log in 
as one of the following users:

� local administrator
� member of the local administrator group
� domain administrator who is a member of the local administrator group

Installing Multiple Rational Products 

If you install individual Rational products and a Rational Suite edition on the same 
system, the system user will first obtain a Suite license by default. To change the order 
in which users obtain licenses on that system, see the Administering Licenses for 
Rational Software manual.

Table 4 RequisitePro Enterprise Database Requirements

Item Requirement

Microsoft SQL Server 7.0 or 2000

Oracle Server Versions 7.3.4, 8.1.5, 8.1.6, 8.1.7

Note: If you are using a version 7.3.4 server, we recommend that you 
use a version 7.3.4 client.

Memory 128 MB minimum; for projects with approximately 50,000 
requirements, 256 MB is recommended.

Note: Memory requirements vary depending on the number of 
concurrent users, the amount of data being requested, and the size of 
the database. 

Disk Space 96 MB
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General Requirements

Here is a list of general requirements for installing Rational RequisitePro and related 
components for the first time at your site.

1 Make sure that you have a current backup of your Registry and system directories. 

2 Install the Rational license keys. You can acquire and import the Rational license 
keys before or after installing Rational RequisitePro. See the Administering Licenses 
for Rational Software manual for more information about licenses, including the 
procedure for obtaining a license key.

Note:  You must install Rational licenses to use Rational products. 

3 The Rational Software Installation procedure uses C:\Program Files\Rational as the 
default install path. 

If your C:\ drive lacks sufficient free disk space, you may either specify another 
drive during the installation procedure or make space available on the default 
drive. Some files will be installed on your C:\ drive; the Software Setup wizard will 
report the amount of space required on all drives for your installation.

Note:  If you have already installed a Rational product, you cannot select an 
alternate location for another Rational product installation.

Note:  The instructions in this guide assume that you are installing Windows 
applications on your C:\ drive. If this is not the case, substitute the appropriate 
drive when performing all procedures.

4 The RequisitePro installation requires specific versions of Microsoft files whether 
you are installing RequisitePro for the first time or upgrading RequisitePro from 
an earlier version. The Rational Software Setup program will install the files, or 
you may choose to install the files from other sources. For more information, see 
Installing Shared Files on page 5.

5 To install the database configuration scripts (for Oracle, or SQL Server), select the 
Custom Installation Type in the Rational Software Setup procedure. 
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Installation Types

The Rational Software Setup program provides you with several installation types, 
allowing you to install the configuration most appropriate for your system. The 
following table describes each type.

Installing Shared Files

The Rational Software Setup program installs shared components that are provided 
by sources other than Rational. These software components are potentially used by 
other applications on your system. Setup installs the U.S. English version of these 
files. It does not overwrite newer file versions.

If the Setup program needs to update shared components it displays a list of the 
shared components that require updates. The files listed must be installed on your 
system before the installation can proceed.

Installing Files Yourself

In general, we recommend that you allow the installation procedure to install shared 
files for you. In the following circumstances, you may want to install the files yourself:

Table 5 Installation Types

Type Description

Typical � Installs the most commonly used features for a product. 
� Use this option for standard installations.

Custom � Allows you to add or remove product features for installation. 
� Defaults to all features in a Typical installation. 
� Use this option to install Web Server Components on a Web Server for 

RequisiteWeb, or database configuration scripts for Oracle, and SQL 
Server.

Compact/Laptop � Installs a subset of the standard configuration. May omit optional 
files, including online documentation or online help. 

� Use this option for installations on systems with limited disk space.

Minimal � Installs the files needed to run the program from a CD or network 
location. 

� Use this option to run the program from a centrally managed location.

Note: You must have write permission to run products from a minimal 
install area.
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� You are using a U.S. English system, but installing new files may invalidate your 
current environment. In this case, you need to determine how to correct your 
environment so that you can run existing tools and the Rational products you 
want to install.

� Your site may mandate that you obtain shared files directly from the source, for 
example, from Microsoft, rather than using files supplied by a third party. Or your 
site may prohibit end users from installing shared components.

� You may want to install equivalent files that are localized to your language.

The check box, Replace files with newer versions in English, is enabled when 
you have installed earlier versions of shared files that are localized to a non-U.S. 
English language. 

❑ If you select this check box, the U.S. English versions of the files will replace 
your localized versions. 

❑ If you clear this check box, you can save and print the list of files that need to be 
updated. You will need to update the files yourself.

� There may be a later version of the files available. Rational products should work 
with the supplied version of shared files or any later versions.

Ensuring Version Compatibility

When you have older Rational products installed on your system, you have to ensure 
that all Rational products on that system are upgraded to the same version. Because 
Rational tools share files and components, a new installation can cause the older 
Rational products to stop working. If the Rational Software Setup detects older 
products on your system, you will see the Upgrade Compatibility dialog box.

For each of the Rational products listed in the Upgrade Compatibility dialog box, we 
strongly recommend that you do one of the following:

❑ Upgrade it: Complete the installation, and then restart the Setup program to 
upgrade the older Rational products. For example, if you have standalone 
installations of Rational point-products on your system, you must upgrade 
each product. If you have a Rational Suite and a point-product on the same 
system, upgrade both Rational products to the same version. Upgrading each 
product updates all necessary files, registry entries, startup menu items, and 
shared components on your system. 

❑ Remove it: Complete this installation and then remove the older Rational 
products from the system.
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Upgrading Rational RequisitePro 

Here is a list of general requirements for upgrading Rational RequisitePro at your site.

� If you are using multiple products from the Rational Suite, all products must be 
from the same Suite version (installed from the same CD-ROM). For information 
about the order in which you should upgrade integrated products and convert 
schemas and data, see Configuring Rational Suite and the Rational Suite Release 
Notes.

� For information on removing RequisitePro from your system, see Removing 
RequisitePro on page 13.

� To upgrade RequisiteWeb, you must remove earlier versions of RequisiteWeb. See 
Uninstalling RequisiteWeb on page 53.

Silent Installations

You can configure Rational Software Setup to perform silent installations of Rational 
software. Silent installations allow you to perform an installation of a Rational 
Software product, using the same parameters, repeatedly on a number of systems. For 
more information on silent installations, see the guide Installing Rational Suites on the 
Rational Solutions for Windows – Online Documentation CD.
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2Installing Rational 
RequisitePro 
This chapter describes how to use the Rational Software Setup wizard to install 
Rational RequisitePro, version 2001A.04.00 

For the most current information related to RequisitePro features and known issues, 
refer to the release notes, which  appear at the end of the RequisitePro installation. The 
release notes are available from a link in the Let’s Go RequisitePro application, which 
appears when you first launch RequisitePro. After the program is installed, you can 
access the release notes from the Windows Start menu in the Rational RequisitePro 
program group. 

Installing RequisitePro with Rational Software Setup 

Caution: Interrupting an installation that is in progress may leave your system in an 
indeterminate state. If you try to close the Rational Software Setup window while the 
installation is in progress, you are asked to confirm that you want to exit from the 
incomplete installation.

This section describes a typical installation of Rational RequisitePro. 

1 Insert the Windows disc 1 into your system’s CD drive. The setup program starts 
automatically. 

If autorun is disabled on your system, click Start  >  Run. Using the drive letter of 
your CD-ROM drive, enter drive:\SETUP.EXE.

The Rational Software Setup wizard will guide you through the software 
installation. On each dialog box, click Next to proceed to the next one.

2 The Rational Software Setup dialog box provides general information about the 
software installation. Click Browse to review Rational product information. To 
view this product gallery, you must have a Web browser. 

3 Choose Rational RequisitePro at the Choose Product dialog box. 

A green dot next to a Rational product indicates you have a license key for that 
product. If you do not see a green dot next to the product you want to install, you 
may want to install license keys before you install the Rational product. Click the 
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Configure Licenses button to launch the Rational License Key Administrator. If 
you do not install the license keys before you install the product, the Rational 
License Key Administrator will appear at the end of the installation.

4 The License Agreement dialog box displays the Rational Software license 
agreement. If you accept the license agreement, the installation continues installing 
Rational Suite on your system. If you do not accept the license agreement, the 
installation does not let you proceed further. If you exit from the installation by 
clicking the Finish button at this point, no changes are made to your system.

5 The Setup Configuration dialog box describes the setup options for this software 
installation. Select the installation option and install path. The options are Typical, 
Custom, Compact/Laptop, and Minimal, described in Installation Types on page 5.

Confirm that you have sufficient free space for the installation. If the amount of 
free space is less than the amount required, either exit from the installation 
procedure and make more space available on the specified disk or specify an 
alternate Install Path. To specify another installation path, type the new path in the 
Install Path field or use the Browse button to select a drive and directory.

The installation program requires that all Rational programs be installed in the 
same directory. If any Rational product has been previously installed with the 
Rational Software Setup program, the browse option and Install Path field are 
disabled. You must remove and reinstall Rational Suite to specify a new Install 
Path.

Note:  The setup procedure installs Microsoft Core Components and some 
additional files on your C:\ drive, even if you have specified an alternate drive for 
installation. These files can require up to 20 MB of disk space on your C:\ drive.

If you are an administrator who is responsible for setting up an Oracle or SQL 
Server database for RequisitePro, select the Custom installation option. If you 
choose either of the other options, go to step 10. When you choose the Custom 
installation option, the Choose Features dialog box appears, which lets you specify 
exactly which features and subfeatures to install on your system. Use the + to 
expand and select or deselect options as desired. Dependencies between some 
features may force an installation option, even if you have deselected it.

6 At the Choose Features dialog box, click Rational RequisitePro and select the Oracle 
Setup or SQL Server Setup option if you plan to use one of those databases for your 
RequisitePro projects.
If you select either option, the program will install schema creation scripts in one 
or both of the following default locations on your local machine: 
10 Chapter 2 - Installing Rational RequisitePro



c:\Program Files\Rational\RequisitePro\database\sqlserver

c:\Program Files\Rational\RequisitePro\database\oracle

For more information on configuring Oracle, or SQL Server for RequisitePro projects, 
refer to Configuring Enterprise Databases on page 15.

7 At the Software Use dialog box, select the option that corresponds to your 
intended use. For more information, refer to Installation Types on page 5.

8 The Update Shared Components dialog box appears if the Rational Software Setup 
program needs to update some shared files or components on your system. Click 
Next to have Rational Software Setup install these files for you or Cancel to install 
these files yourself. For additional information, see Installing Shared Files on page 5 
or the Rational Software Setup online help.

Note:  The Rational Software Setup wizard does not recalculate the disk space 
required for your updated selections. 

9 The Upgrade Compatibility dialog box appears if you have older Rational 
products installed on your system. Because Rational tools share files and 
components, this installation can cause the older Rational products to stop 
working. You will see no visual clue to indicate that the older products may be 
compromised.

For each of the older products listed, we strongly recommend that you take one of 
the following actions:

❑ Upgrade it: Complete this installation, and then restart the Setup wizard to 
upgrade the next product. Upgrading a product updates all necessary files, 
registry entries, startup menu items, and shared components on your system.

❑ Remove it: Complete this installation, and then use the Control Panel's 
Add/Remove Programs tool to remove the next product. Removing a product 
deletes files, registry entries, and startup menu items from your system.

More information about interactions between specific products is available at the 
Web site http://www.rational.com/sitewide/support/index.jtmpl. Click Patches 
and Upgrades, and then click Upgrade Compatibility.

10 The Confirmation dialog box displays the product features that will be installed.

11 The Error Summary dialog box displays errors from the first part of the software 
installation. If the installation is successful, you will not see this dialog box.

The Rational Software Setup program writes a log of installation activities. The log 
file is located in <Install Path>\Rational\RSSetup\RSsetup.log.
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Possible Reboot Required

If files required for the installation are in use during the Rational Software Setup 
program, and if the program needs to install shared components on your system, the 
Setup program may require that you reboot your system. After rebooting, do the 
following:

1 Log on as the same administrator identity to complete the installation procedure. If 
you do not log on as the same administrator identity, the installation does not 
complete correctly. The installation process completes on your system.

2 Click Finish to exit from the Rational Software Setup program. 

Configuring E-mail for Discussions

Use the Rational E-mail Reader application to configure e-mail for all discussion 
participants with a valid e-mail address in their RequisitePro user information. The 
Rational E-mail Reader application is included with your Rational Software 
installation at the following default location: 
c:\Program Files\Rational\common\mailreader.exe

This application offers full e-mail integration with RequisitePro by associating an 
e-mail handler with each RequisitePro project. Initial discussion items and replies are 
automatically stored in the RequisitePro database and sent to discussion participants 
via e-mail. Participants can reply to the discussion items using their e-mail, as well as 
from within RequisitePro. 

Caution: The E-mail Setup option on the RequisitePro Tools menu only configures 
notification e-mail for users who initiate a discussion or reply to a discussion from 
within the RequisitePro Discussion dialog box. To allow users to reply to discussions 
via e-mail, and to enable discussion e-mail for RequisiteWeb users, configure an 
e-mail handler for each project using the Rational E-mail Reader.

Discussion E-mail Configuration Requirements  
� You must configure a unique e-mail address for each RequisitePro project

� For RequisiteWeb: You must run the Rational E-mail Reader on a different server 
than the Internet Information Services (IIS) server where RequisiteWeb is installed.

� For RequisitePro and RequisiteWeb: In order to enable e-mail for RequisiteWeb 
discussions, you must configure discussion e-mail using the SMTP protocol 
option in the Rational E-mail Reader. The MAPI protocol option is not supported 
for RequisitePro and RequisiteWeb.
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� In order to complete the Rational E-mail Reader setup for SMTP protocol, you 
need the following information from your e-mail administrator:
- SMTP Server name
- POP3 Server name
- E-mail address; one for each RequisitePro project
- POP3 server login and password for the e-mail address

� Be sure to specify a Log File Path on the Reader Information and Options tab in the 
Rational E-mail Reader.

Note:  Refer to the online help in the Rational E-mail Reader for more information. 

Removing RequisitePro

This section describes how to remove RequisitePro from your system.

Preparing to Remove RequisitePro

Make sure that no one is using RequisitePro and any associated files. You will not be 
able to remove files that are in use.

To remove RequisitePro from a Windows NT system, you must have Windows NT 
administrator privileges on the local machine.

To Remove RequisitePro

Use the Windows Add/Remove Programs control panel to select and remove 
RequisitePro. The Rational Software Setup removes RequisitePro from your system.

Note:  Removing RequisitePro does not remove RequisitePro project data from your 
system.

Note:  If you are upgrading to a new version of RequisitePro that uses a different 
installation path and you choose to leave the previous directories intact, you should 
delete the .gid files from your former help directories; for example: 
\Rational\RequisitePro 4.5\help\reqpro.gid 
This prevents the new RequisitePro help from looking in the old directories for its 
contents information.
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3Configuring Enterprise 
Databases  
Introduction

This chapter describes how to configure Oracle® and Microsoft® SQL Server 
databases for RequisitePro projects. This information is also available in electronic 
format.

Note:  The use of client/server databases offers significantly increased power and 
expandability to your organization's implementation of Rational RequisitePro. 
RequisitePro can be used with Oracle7, Oracle8, Microsoft SQL Server 7.0, and 
Microsoft Access databases. The RequisitePro Data Transfer Wizard enables you to 
move a Rational RequisitePro project from one database to another. 

Database Setup

To create and access RequisitePro projects in Oracle, or Microsoft SQL Server 
databases, you must configure an Oracle, or SQL Server schema on your database 
server. Refer to Oracle or Microsoft documentation for information on installing 
Oracle, or Microsoft SQL Server. To configure an Oracle, or SQL Server database for 
RequisitePro projects, refer to the sections Configuring Oracle for RequisitePro on 
page 16 and Configuring SQL Server for RequisitePro on page 27. 

Client Installation

Access to RequisitePro projects on Oracle and SQL Server databases requires the 
installation of RequisitePro on the client PC. If you are using an Oracle  database, you 
must also install the Oracle client software on your PC. 

See System and Software Requirements on page 2 for RequisitePro system requirements.

Installing Database Configuration Scripts 

If you are responsible for setting up an Oracle or SQL Server database for 
RequisitePro, you should have installed the database configuration scripts with the 
Custom installation option, described in Installing RequisitePro with Rational Software 
Setup on page 9. 
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If you selected the Oracle or SQL Server options, the program installed schema 
creation scripts in one or both of the following locations on your local machine: 
C:\Program Files\Rational\RequisitePro\database\oracle  

C:\Program Files\Rational\RequisitePro\database\sqlserver

Configuring Oracle for RequisitePro

Purpose

This section provides information about configuring Rational RequisitePro for use 
with an Oracle database server. It includes:

� database management information for setting up an Oracle schema to 
accommodate Requisite projects, 

� instructions for accessing an Oracle host from the client PC using Oracle's 
SQL*Net or Net8 Easy Configuration tool, and

� a procedure for creating a RequisitePro project in the Oracle database.

These instructions are intended for use by Oracle database administrators, system 
administrators, and RequisitePro project administrators.

For the most current information related to Oracle database configuration, refer to the 
“Oracle Database Configuration for RequisitePro” document that is, by default, at the 
following location on your system after installation: 
C:\Program Files\Rational\RequisitePro\help\OracleSetup.html

Introduction

To create and access RequisitePro projects in the Oracle database, follow the 
instructions in this document for enabling your Oracle database compatibility. 
RequisitePro supports multiple projects within a single Oracle schema. Refer to 
Creating a Project in Oracle on page 24 for instructions on adding an Oracle database 
project within RequisitePro. Use the same schema name for each of your RequisitePro 
projects.

Prerequisites

This document assumes that you have Oracle installed on your LAN and the Oracle 
client software installed on your PC. Refer to the Oracle documentation for all 
questions regarding that product.

The following installation and configuration tasks must be accomplished prior to 
performing the RequisitePro/Oracle integration outlined in this document.
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Oracle Database Administration

Notice to database administrator: 
For proper execution of the RequisitePro application, be sure to set the initialization 
parameter, OPEN_CURSORS, to at least 110.

In order to configure access to Oracle for RequisitePro projects, the database 
administrator must establish the following:

� Oracle database server name (TCP/IP Host Name)

� Oracle database alias or service name

� Oracle schema name for storing RequisitePro projects (see procedure below)

� your user ID for logging on to the Oracle database

� your user password for logging on to the Oracle database

The following sections provide instructions for configuring the last three of these 
items.

Platform Compatibility

RequisitePro database implementation is compatible with all Oracle-supported 
platforms.

Creating an Oracle Schema for RequisitePro

Oracle database administration allows the creation of multiple schemas within your 
Oracle database instance. Use the scripts listed below to create a RequisitePro user 
and schema within Oracle for storing your projects. The RequisitePro scripts are 
designed to initially allocate disk space for the various database tables and indexes 
that are used by RequisitePro, based on the following approximations: 

� 25 projects

� 250 documents (10 per project)

� 125 document types (5 per project)

� 125 requirement types (5 per project)

� 1,250 user defined attributes (10 per requirement type)

� 125 user groups (5 per project)

� 100 users

� 12,500 requirements (500 per project)
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� 12,500 discussions (500 per project)

The scripts simply provide an initial size for the RequisitePro schema. They in no way 
imply any constraints on size or number of projects. 

Extents are set to the same size as the initial allocations. They define additional table 
space that Oracle will allocate if the original allocation becomes insufficient.

As database administrator, you can customize the scripts to adjust the table space 
allocations for tables and indexes in order to accommodate your organization's 
intended use of RequisitePro. See the section Editing Scripts on page 19.

Schema Creation Scripts

The following scripts are used for creating a RequisitePro schema within your Oracle 
database. They can be run automatically by executing the main script, 
CREATE_REQPRO, as described in the procedure Creating a Schema on page 21, or 
you can run them individually as needed.

CREATE_REQPRO. Establishes a log that can be used to review the results of 
running the script and runs the other scripts, listed below.  

TABLESPACE. Creates table spaces for data and indexes. Creates disk files to support 
these table spaces.

CREATE_USER. Creates the default RequisitePro user (REQPRO) and password 
(REQPRO) and connects to the database with that user ID.

TABLES.  Creates tables for the RequisitePro database.

PRIMARY. Creates primary keys for each table in RequisitePro.

INDEXES. Creates indexes for the RequisitePro database.

FOREIGN.  Creates foreign key relationships between tables.

FUNCTIONS. Creates customer-defined functions for use within RequisitePro.

SEQUENCE.  Creates sequences and triggers for auto-sequencing primary keys.

PROCEDURES. Creates stored procedures for use within RequisitePro.

DATA. Inserts data into the RqKeys and RqRequisite tables.

GRANT_ROLE. Creates a user role with access to the RequisitePro schema objects.
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Installing the RequisitePro Scripts

If you did not install the Oracle database creation scripts as described in Installing 
RequisitePro with Rational Software Setup on page 9, you must repeat the Custom 
installation procedure.

After installation, the scripts are located, by default, at the following location on your 
local machine: 

C:\Program Files\Rational\RequisitePro\database\oracle

Copy the scripts to a subdirectory on your Oracle database server. We suggest that 
you create a “sql” directory below the home directory on the server.

Note:  If your database server is running on an international operating system, be sure 
that the path to these scripts does not include folders with double-byte character 
names.

Editing Scripts

All modifications described below are made in the CREATE_REQPRO script, unless 
otherwise indicated. 

Modifying the User Name and Password (Optional)

If you want to create the RequisitePro schema with a different entry than the default 
user name and password values of “ReqPro”, modify the following entries:

   DEFINE USR=reqpro

   DEFINE PWD=reqpro

Specifying the Path for the Schema Scripts

Edit the DEFINE PATH entry to indicate the full path where the RequisitePro SQL 
scripts are located. The suggested path (from “Installing the RequisitePro Scripts,"  
above) is: 

   DEFINE PATH="$HOME/sql/"

Note:  If your environment limits your path to a maximum 8-character name for 
directories, be sure to reflect this format in your entry.

Indicating Data and Index Files Directory

Edit the DEFINE ORACLE_DATA entry to indicate the path and directory where the data 
file for the data table space will be created:

   DEFINE ORACLE_DATA=<full path>/ORACLE_DATA/
Configuring Oracle for RequisitePro 19



Edit the DEFINE ORACLE_INDEX entry to indicate the path and directory where the 
data file for the index table space will be created:

   DEFINE ORACLE_INDEX=<full path>/ORACLE_INDEX/

Specifying a Temporary Tablespace

Edit the DEFINE TEMP entry in the CREATE_REQPRO script to assign temporary 
tablespace for storing temporary objects for the user’s operations.

   DEFINE TEMP=TEMP

Make sure that the value for this entry is a valid, existing tablespace in your Oracle 
database. Some versions of Oracle use “TEMPORARY_DATA” rather than “TEMP.” 
Your installation of Oracle may contain a custom name for the temporary tablespace.

Customizing Disk Space Allocation for Database Objects

The schema creation scripts are designed to allocate disk space for the various 
database tables and indexes that are used by an average set of RequisitePro projects, 
as described in Creating an Oracle Schema for RequisitePro on page 17. 

If you anticipate a much larger or smaller requirement for your organization's use of 
RequisitePro, you can customize the disk space allocation specified in the 
CREATE_REQPRO script to accommodate your projected capacity. 

Edit the following sizing variables: 

   SMALL    = 10K

   MEDIUM   = 100K 

   LARGE    = 1000K

   REQS     = 6000K 

   REQHIST  = 75000K 

Note:  The last two variables, REQS and REQHIST, are used for the requirements 
(RqRequirements) and requirement history (RqRequirementHistory) tables, 
respectively.  

Edit the DEFINE DATA_SIZE and DEFINE INDEX_SIZE entries to reflect the change in 
the total size of the database caused by your edits to the sizing variables.

Modifying the Limits of the VARCHAR2 Data Type

RequisitePro uses the VARCHAR2 data type to store searchable text for requirement 
text, revision history reasons, and textual attribute values. 
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Although Oracle7 supports a maximum of 2,000 characters in the VARCHAR2 data 
type, Oracle8 supports up to 4,000, allowing you to expand the constraints on the size 
of the searchable text from 2,000 to 4,000 characters. 

The RequisitePro Oracle scripts set the limit on this data type to 2000 characters to 
accommodate both Oracle7 and Oracle8 databases. To modify this limit for Oracle8 
databases, increase the MAX_VARCHAR value in the CREATE_REQPRO script from 
2000 to a maximum of 4000. 

Creating a Schema

The Oracle database administrator performs the following procedure to create a 
RequisitePro schema in Oracle:

1 Edit the CREATE_REQPRO script, as described above in the section Editing Scripts 
on page 19.

2 On the Oracle database server, log on to SQL*Plus with system administrator 
permissions.

Note:  If you run SQL*Plus from a remote client, you need to edit the RequisitePro 
CREATE_USER script. Change the entry connect &3/&4 to the following:
connect &3/&4@<target Oracle database server alias>

3 Run the CREATE_REQPRO script using the command:
@<setup directory>\CREATE_REQPRO

This script runs the schema creation scripts. A message appears upon successful 
completion of the schema creation. If errors occur or the completion message does not 
appear, review the log CREATE_REQPRO.LOG.

User ID for Accessing Oracle Database

All RequisitePro projects should access the Oracle database using the same user ID, 
which was created during the schema creation process, described above. The initial 
user name and password created by the script are "reqpro" and "reqpro", unless you 
modified the CREATE_REQPRO script, as described in Editing Scripts on page 19. You 
can also change the password using your Oracle database utilities. 

Each user does not need a separate Oracle account because RequisitePro uses its own 
user and user group tables to control access to a project.
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Using Multiple Projects within an Oracle Database

RequisitePro supports multiple projects within a single Oracle schema. Refer to the 
procedure Creating a Project in Oracle on page 24 for instructions on adding an Oracle 
database project within RequisitePro. Use the same schema name for each of your 
RequisitePro projects.

Connecting Projects Across Databases

Perform the following steps to enable cross-project traceability between projects in 
distributed Oracle databases. Refer to the following sections for details.

� Creating a reference to the remote database instance

� Creating a database link to the remote database

� Defining database aliases on each RequisitePro client

Creating a reference to the remote database instance

In order to run traceability queries between projects in distributed Oracle databases, 
you need to define a reference in each database instance that refers to the remote 
database instances. Edit the tnsnames.ora file, located on the Oracle server, to define 
the name, host, port, and protocol of the remote service. 

The following example shows the syntax for defining the database instance 
“server02” as a remote database server to “server01” in the tnsnames.ora file:

Server02.world = 
  (DESCRIPTION = 
    (ADDRESS_LIST =
      (ADDRESS = 
          (COMMUNITY = tcp.world)
          (PROTOCOL = TCP)
          (Host = server02)
          (Port = 1521)))
    (CONNECT_DATA = (SID = ORCL)))

In similar fashion, the “server02” database instance needs an entry to define the 
remote “server01” database instance:

Server01.world = 
  (DESCRIPTION = 
    (ADDRESS_LIST =
      (ADDRESS = 
          (COMMUNITY = tcp.world)
          (PROTOCOL = TCP)
          (Host = server01)
          (Port = 1521)))
    (CONNECT_DATA = (SID = ORCL)))
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Note:  This feature was tested using TNSNAMES for service name resolution. Use of 
Oracle Names Server or any other name server mechanism requires a different setup.

Creating a database link to the remote database

Next, create a database link to each remote database in each database instance using a 
SQL utility. The link should be defined under the user account that owns the 
RequisitePro schema. The following example shows the required syntax for linking to 
“server02” from “server01”:

   CREATE DATABASE LINK server02.world

   CONNECT TO reqpro IDENTIFIED BY reqpro

   USING ‘server02.world’;

A similar statement should be executed on the server02 database instance in order to 
define a link to server01.

If the db_name.db_domain does not result in a unique name for each database for 
which a link is required, use the @connection_qualifier syntax to create a unique 
name.

This naming convention will work regardless of the setting of the global_names 
parameter in the initorcl.ora file.

Defining database aliases on each RequisitePro client

Define SQL*Net database aliases or Net8 service names (resulting in local 
tnsnames.ora file entries) on each RequisitePro client machine (or shared centrally on 
a network) for each database instance. The database alias or service name on the client 
MUST match the database link you defined in the previous step for RequisitePro 
cross-project traceability to function correctly. 

For more information on configuring client PCs for use with a Rational RequisitePro 
Oracle database, refer to the following section.

Setting Up PCs for Oracle Access

Use the Oracle SQL*Net or Net8 Easy Configuration tool to configure access from 
your client PC to the Oracle database server. If you plan to share projects with other 
users, be sure to use a consistent database alias or service name, as determined by 
your database administrator.
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Creating a Project in Oracle
Note:  To convert a project from an existing Microsoft Access database to an Oracle 
database, use the Database Type Conversion Wizard. Open the Database Type 
Conversion Wizard in Windows Explorer. The executable, rqdbtypewiz.exe, is 
located in the directory: \Program Files\Rational\RequisitePro\bin\ 

Perform the following steps to create a RequisitePro project that uses the Oracle 
database server for storing the RequisitePro project database.

In order for you to configure your access to Oracle from RequisitePro, the database 
administrator must provide the following information:

� Oracle database server name (TCP/IP Host Name)

� Oracle database alias or service name

� Oracle schema name for storing RequisitePro projects (see procedure below)

� your user ID for logging on to the Oracle database

� your user password for logging on to the Oracle database

1 In RequisitePro on the Project menu, click New. The Create RequisitePro Project 
dialog box appears.

2 Select a project template.

Note:  The details in the lower part of the dialog box provide an explanation as you 
select each template.

3 Click Create. The Rational RequisitePro Project Properties dialog box appears.

4 Enter a project name and directory location.
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5 At the Database field, select Oracle from the drop-down list and click the 
Properties button. The Database Properties dialog box appears.

6 Click the Configure button. The Microsoft ODBC for Oracle Setup dialog box 
appears.

  

7 Do not modify the default entries in the Data Source Name and Description 
fields.

8 Type your User Name for logging into the Oracle database, as provided by your 
Oracle database administrator. By default, the user name is "reqpro".

9 For the Server field, type the alias or service name you entered when configuring 
your PC for access to the Oracle database.

Note:  This database alias or service name must be identical when configuring all 
PCs that will access shared RequisitePro projects in the Oracle database.

10 Click OK. The Database Properties dialog box appears.

11 Click the Account Info button. The Database Account Info dialog box appears.
  

12 Do not modify the User ID field. This should match the user name you entered in 
the previous dialog box. 

reqpro
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13 Type your user password for logging into the Oracle server. This should be 
supplied to you by your Oracle database administrator.

14 Retype your password in the Verify Password field.

15 In the Schema field, type the name of the Oracle schema that your Oracle 
database administrator has established for storing RequisitePro data in Oracle.

16 Click OK to close the Database Account Info dialog box. Click OK to close the 
Database Properties dialog.

17 Finish creating your project, then click OK to close the Project dialog box.

Archiving and Baselining an Oracle Project

Refer to the topics “Archiving enterprise database projects” and “Baselining projects 
with Unified Change Management” in the RequisitePro online help. These help topics 
are also available in Let’s Go RequisitePro. Click the Project Administration Tips icon 
and select the appropriate link.

Deleting Data from an Oracle Project
Note:  You will no longer be able access project data once the Oracle project data has 
been deleted.

To delete data from an Oracle project on your database server click Start > Programs > 
Oracle > Application Development > SQL Plus.  Log on as the ReqPro user and from 
the SQL> command prompt type the following:

     select id, name from rqprojects;

This will list the ID and Name of all of the projects within your schema.  Once you 
have identified the project that includes the data you wish to delete type the following 
from the SQL> command prompt:

     exec rqdelete_project (project ID#);

Be sure to replace (projet ID#) with the ID number of the project you wish to delete. 
Once the exec rqdelete_project command is executed all data from the Oracle 
project that you selected will be deleted.
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Configuring SQL Server for RequisitePro

Purpose

This section provides information about configuring Rational RequisitePro for use 
with Microsoft SQL Server. The section includes:

� database management information for setting up a SQL Server schema to 
accommodate RequisitePro projects

� a procedure for creating a RequisitePro project in the SQL Server database

This document is intended for use by SQL Server database administrators, system 
administrators, and RequisitePro project administrators.

For the most current information related to SQL Server database configuration, refer 
to the document “SQL Server Database Configuration for RequisitePro” that is, by 
default, at the following location on your system after installation: 
C:\Program Files\Rational\RequisitePro\help\SQLsetup.html

Introduction

To create and access RequisitePro projects in the SQL Server database, follow the 
instructions in this section for enabling your SQL Server database compatibility. 
RequisitePro supports multiple projects within a single SQL Server schema. Refer to 
the procedure Creating a Project in SQL Server on page 31 for instructions on adding an 
SQL Server database project within RequisitePro. Use the same schema name for each 
of your RequisitePro projects.

Prerequisites

This document assumes that you have SQL Server, Version 7.0 or 2000, installed on 
your LAN. Refer to the SQL Server documentation for all questions regarding that 
product.

Note:  If you have an existing RequisitePro database in SQL Server, and your SQL 
Server software has been upgraded to version 7.0 or 2000 from a previous version, 
then you must run the following stored procedure in SQL Server to set the database 
compatibility level to 70 for SQL Server 7.0 or 80 for SQL Server 2000:

sp_dbcmptlevel <database name>, 70 (or 80)

for example: 

sp_dbcmptlevel RequisitePro, 70

The above procedure is required to prevent SQL Server Syntax Errors in RequisitePro.
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The following installation and configuration tasks need to be accomplished prior to 
performing the RequisitePro/SQL Server integration outlined in this document.

SQL Server Database Administration

Prior to configuring your access to SQL Server from RequisitePro, the database 
administrator must establish the following:

� SQL Server machine name (TCP/IP Host Name)

� SQL Server default database for RequisitePro projects, such as “RequisitePro”

� a user ID for logging on to the SQL Server database, such as “ReqPro”

� a user password for logging on to the SQL Server database, such as “reqpro”

The following sections provide instructions for configuring the last three of these 
items.

Platform Compatibility

RequisitePro database implementation is compatible with all Microsoft SQL 
Server-supported platforms.

Creating a SQL Server Database for RequisitePro 

Use the following instructions to create a SQL Server database and schema for 
RequisitePro projects. The initial database size is based on the following 
approximations for your use of RequisitePro: 

� 25 projects

� 250 documents (10 per project)

� 125 document types (5 per project)

� 125 requirement types (5 per project)

� 1,250 user-defined attributes (10 per requirement type)

� 125 user groups (5 per project)

� 100 users

� 12,500 requirements (500 per project)

� 12,500 discussions (500 per project)
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To create a database in SQL Server 7.0, do the following:

1 Enter a name for the RequisitePro database. The database has an .MDF extension. 
The recommended database name is “RequisitePro.”

Note:  If you use a different database name, you will need to modify the database 
configuration scripts to reflect the actual name.

2 Set the initial size of the database to 150 MB.

3 Set the initial size of the transaction log file (.LDF) to one third the size of the 
database (in this case, 50 MB).

Schema Creation Scripts

The scripts listed below are used for creating a RequisitePro schema within your SQL 
Server database. 

� Login and User. Creates a default RequisitePro login and user. For more 
information refer to the section below, “Default Login and User.” 

� Tables and Indexes. Creates the tables and indexes required by RequisitePro.

� Triggers. Creates triggers that enforce cascading deletes.

� Initial Data. Inserts data required by RequisitePro when it first runs.

Installing the RequisitePro Scripts

If you did not install the SQL Server database creation scripts as described in Installing 
RequisitePro with Rational Software Setup on page 9, you must repeat the Custom 
installation procedure. 

After installation, the scripts are located, by default, at the following location on your 
local machine:  

C:\Program Files\Rational\RequisitePro\database\sqlserver

Copy the scripts to a subdirectory on your SQL Server database server. We suggest 
that you create a “sql” directory below the home directory on the server.

Running Schema Creation Scripts

The scripts listed below are used for creating a RequisitePro schema within your SQL 
Server database. Run the scripts in the sequence presented below. Run the scripts 
individually using the SQL Server Query Analyzer. Be sure to select the RequisitePro 
database in the DB drop-down list when running the scripts.
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1 login and user.sql   

2 tables and indexes.sql 

3 triggers.sql  

4 initial data.sql

Default Login and User

The schema creation scripts, described above, create default user information for 
accessing and creating projects in SQL Server. The user name also establishes the 
ownership and name of the schema (by default, “reqpro”). The default user 
permissions are required for use with RequisitePro.

Note:  If you modify the login and user.sql script to use a different login and user 
name, you will need to modify subsequent scripts.

The scripts create the following default user information:

The ReqPro user is assigned the following statement permissions in SQL Server:

As the owner of the RequisitePro database objects, the ReqPro user is automatically 
assigned the following database permissions in SQL Server:

User Login Password

ReqPro ReqPro reqpro

User Statement Permissions

ReqPro Create Default, Create Procedure, Create Rule, 
Create Table, Create View

User Database Permissions

ReqPro Select, Insert, Update, Delete, DRI on all Tables 
and Views
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Creating a Project in SQL Server
Note:  To convert a project from an existing Microsoft Access database to an Oracle 
database, use the Database Type Conversion Wizard. Open the Database Type 
Conversion Wizard in Windows Explorer. The executable, rqdbtypewiz.exe, is 
located in the directory: \Program Files\Rational\RequisitePro\bin\ 

Perform the following steps to create a RequisitePro project that uses the SQL Server 
for the project database.

In order to configure access to SQL Server from RequisitePro, the database 
administrator must provide you with the following information:

� SQL Server machine name (TCP/IP Host Name)

� SQL Server default database for RequisitePro projects, such as “RequisitePro”

� a user ID for logging on to the SQL Server database, such as “ReqPro”

� a user password for logging on to the SQL Server database, such as “reqpro”

1 Start RequisitePro. In RequisitePro on the Project menu, click New. The Create 
RequisitePro Project dialog box appears.

2 Select a project template.

Note:  The details in the lower part of the dialog box provide an explanation as you 
select each template.

3 Click Create. The Rational RequisitePro Project Properties dialog box appears.

4 Enter a project name and directory location.

5 At the Database field, select SQL Server from the drop-down list.
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6 Click the Properties button. The Database Properties dialog box appears.
             

7 At the Database Properties dialog box, click the Configure button. The “Create a 
New Data Source to SQL Server” dialog box appears.

  

8 Do not modify the data source Name or Description fields. In the Server field, 
type the name of the SQL Server, supplied by your database administrator.
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9 Click Next. The second data source screen appears.
  

10 Select the option With SQL Server authentication using a login ID and
password entered by the user.

Note:  RequisitePro does not support Windows NT authentication.

11 Be sure the check box Connect to SQL Server to obtain default settings for the
additional configuration options is checked.

12 Type the login ID and password supplied by your database administrator, such as 
“ReqPro” and “reqpro.” Click Next.

13 Click the check box Change the default database to and select a database name 
supplied by your database administrator, such as “RequisitePro.” Click Next.

14 Click Next to accept the default language, character, and regional settings. The use 
of log files, shown on the following screen, is optional.

Note:  Do not select the check box Change the language of SQL Server system
messages to... Selecting this check box prevents users from opening the project 
after its initial creation.

15 Click Finish. The ODBC Microsoft SQL Server Setup dialog box appears.

16 Click the Test Data Source button. The SQL Server ODBC Data Source Test dialog 
box appears.

17 Click OK. The ODBC Microsoft SQL Server Setup dialog box appears.
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18 Click OK. You return to the Database Properties dialog box.

19 At the Database Properties dialog box, click the Account Info button. The 
Database Account Info dialog box appears.

  

20 Type the User ID and Password, supplied by your database administrator for 
accessing the SQL Server database, such as “ReqPro” and “reqpro.”

21 Retype your password in the Verify Password field.

22 In the Schema field, type the user name of the owner of the RequisitePro database 
tables, supplied by your database administrator, such as “ReqPro.”

23 Click OK to close the Database Account Info dialog box. Click OK to close the 
Database Properties dialog box.

24 Finish creating your project, then click OK to close the Project dialog box.

Archiving and Baselining an SQL Server Project

Refer to the topics “Archiving enterprise database projects” and “Baselining projects 
with Unified Change Management” in the RequisitePro online help. These help topics 
are also available in Let’s Go RequisitePro. Click the Project Administration Tips icon 
and select the appropriate link.

Deleting Data from a SQL Project
Note:  You will no longer be able to access project data once the SQL project data has been 
deleted.

To delete data from an SQL project on your database server click Start > Programs > 
Microsoft SQL Server > Query Analyzer.  Log on as the ReqPro user and in the 
Query Window type the following:

     select id, name from rqprojects
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Execute the query and it will list the ID and Name of all of the projects within your 
schema.  Once you have identified the project that includes the data you wish to 
delete type the following in the Query Window:

     exec rqdelete_project (project ID#)

Be sure to replace (projet ID#) with the ID number of the project you wish to delete. 
Once the exec rqdelete_project query is executed all data from the SQL project 
that you selected will be deleted.
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4Installing and 
Configuring Rational 
RequisiteWeb

Introduction

This chapter presents instructions for configuring a Windows Web server for 
RequisiteWeb.

Rational RequisiteWeb allows clients to read, create, and modify Rational 
RequisitePro project requirements across an intranet. RequisiteWeb uses the browsers 
Netscape Navigator and Microsoft Internet Explorer to provide 
platform-independent, thin-client access to RequisitePro project data. RequisiteWeb 
can only be installed on a Windows server.     

This chapter contains the following sections:

� RequisiteWeb System Requirements

� Configuring the RequisiteWeb Server 

� Configuring the Web Server Components 

� Configuring E-mail for Discussions 

� Uninstalling RequisiteWeb

� Troubleshooting

For the most current information on RequisiteWeb, including installation, 
configuration, and known issues, refer to the RequisiteWeb Installation and 
Configuration document that is on the Rational Solutions for Windows CD at:
\RequisitePro\ReqWeb\RequisiteWebInstall.html
It is also located, by default, in your RequisiteWeb installation at: 
C:\Program Files\Rational\RequisitePro\ReqWeb\RequisiteWebInstall.html

The RequisiteWeb Installation and Configuration document is also available from the 
online Release Notes in RequisitePro.
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RequisiteWeb System Requirements

Server Requirements

The following table summarizes the requirements for the RequisiteWeb server.
Table 6 RequisiteWeb Server Requirements

Item Requirement

Operating System One of the following:

Microsoft Windows 2000 Advanced Server

NT Server 4.0, Service Pack 6A or later; NT 4.0 Option Pack

HTTP Server One of the following:

Internet Information Server (IIS) 4.0 and Microsoft Transaction 
Server (MTS) 2.0

Internet Information Services (IIS) 5.0 

Processor 400 MHz or greater

Memory 128 MB. For projects with more than 10,000 requirements or Web sites 
with more than 10 concurrent users, 256 MB or more is 
recommended.

Disk space RequisiteWeb (includes system DLLs) -- 40 MB

Other products Microsoft Word 2000 
Note: Microsoft Word licenses are required for all concurrent 
RequisiteWeb end users.

Oracle, version 7.3 or greater, client software (for accessing 
projects in an Oracle database).

Microsoft Internet Explorer 5, 6 
or Internet Explorer 4 with the XML parser available at  
http://msdn.microsoft.com/downloads/tools/xmlparser/x
mldl.asp
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Note:  The RequisiteWeb server cannot be implemented on a Primary Domain 
Controller or Backup Domain Controller. 

RequisiteWeb Security Requirements

Use caution when modifying permissions on RequisiteWeb-related folders. 

Client Requirements

To access RequisiteWeb from client machines, you must install one of the following 
Web browsers on the client system. No additional client installation is required for use 
of RequisiteWeb.

� Microsoft Internet Explorer 4.X or 5.X

� Netscape Navigator 4.X or 6.X

Note:  For proper RequisiteWeb operation, you must set your browser to allow 
cookies.

Configuring the RequisiteWeb Server 

Before you configure RequisiteWeb, Microsoft Internet Information Server (IIS) and 
Microsoft Word must be installed on your Windows server. For more information on 
IIS, see Microsoft Servers at http://www.microsoft.com/servers.

This section describes installation and configuration of the RequisiteWeb components 
on your server. The following procedures are provided: 

� Installing the Oracle Client

� Creating the RequisiteWeb User on the Windows Domain Server

� Adding the ReqWeb User to the Local Administrator Group

� Assigning DCOM Permissions to the Local Administrators Group

� Configuring the Web Server Components

Installing the Oracle Client

To access RequisitePro projects that are stored in an Oracle database, you must 
configure Oracle client software on the server.

Important: When setting up RequisiteWeb on a server, you must install the Oracle 
client software before installing RequisiteWeb if you are using a version of Oracle 
earlier than Oracle 8.1.7.
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Creating the RequisiteWeb User on the Windows Domain Server

RequisiteWeb requires that you create an administrative user, ReqWebUser, for 
accessing RequisiteWeb components

When you create the ReqWeb user on the Windows domain server be sure to log on to 
your Windows domain server as an administrator.

Table 7 Creating a Domain User 

Step NT 4.0 Windows 2000 Server

1 On the domain server, click Start > 
Programs > Administrative Tools (Common) > 
User Manager for Domains.

On the domain server, click Start > Programs 
> Administrative Tools > Computer Management.

2 Click User > New User. Expand Domain Users and Groups. Right-click 
on Users; select New User.

3 In the Username field, type ReqWebUser 
and type a password of your choice.

In the Username field, type ReqWebUser 
and type a password of your choice. 

4 Clear the check box User must change 
password at next login and select the check 
box Password never expires. Click Add; 
click Close.

Clear the check box User must change 
password at next logon and select the check 
box Password never expires. Click Create; click 
Close.

5 Click the Groups button. In the Not a 
Member Of list select Domain Admins 
and click Add. Click OK twice.

Double-click the ReqWebUser. In the 
ReqWebUser Properties dialog box select 
the Member Of tab and click Add. Select 
your domain from the Look in field. Select 
Domain Admins from the Name column 
and click Add. Click OK.

5 Close the User Manager application. Close the Computer Management application.
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Adding the ReqWeb User to the Local Administrator Group
Note:  Be sure to log on to your RequisiteWeb server as a local user for the following 
procedure.

Note:  If any of your RequisitePro project files are located on a server other than the 
Windows server, the ReqWebUser must have Change or Modify permission for the 
directory containing the RequisitePro (.rqs) project file on the remote file server.

Assigning DCOM Permissions to the Local Administrators Group

RequisiteWeb uses the DCOM and a local user with Administrator permissions to 
launch Microsoft Word.

Note:  If you have not already installed Microsoft Word you must do so now.

Use DCOM to give the ReqWebUser user access and launch permissions for 
Microsoft Word and Microsoft Word Basic, if it appears in your DCOM application 
list. The following sections provide detailed instructions for these procedures.

Table 8 Adding the ReqWebUser to the Local Administrators 

Step NT 4.0 Windows 2000 Server

1 On the Windows server, click Start > 
Programs > Administrative Tools (Common) > 
User Manager for Domains.

On the Windows server, click Start > 
Programs > Administrative Tools > Computer 
Management.

2 Click User > Select Domain and select your 
domain server and type your machine 
name. Click OK.

Expand Local Users and Groups. Select Groups. 
Right-click Administrators and select Add to 
Group. In the Administrators Properties 
dialog box, click Add.

3 Under the Groups column double-click 
Administrators.

The Select Users or Groups dialog box 
appears. At the Look in field, select the 
domain where you created the ReqWebUser. 

4 In the Local Group Properties dialog box 
click Add. Select your Domain Server in 
the List Names From drop-down menu. 
Select ReqWebUser in the Names list and 
click Add. Click OK.

Select the ReqWebUser and click Add. 

5 Click OK in the Local Group Properties 
dialog box to close it.

Click OK to close the Select Users or Groups 
dialog box. Click OK to finish.

6 Close the User Manager application. Close the Computer Management application.
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To Assign Access Permissions to the Local Administrators Group:

1 On the Start menu, click Run, and type dcomcnfg

Note:  At this point you may see the DCOM Configuration Warning dialog box. 
Disregard the warning and proceed to the next step.

2 Select the Default Security tab. Under Default Access Permissions click the Edit Default 
button. 

3 In the Registry Value Permissions dialog box click Add.

4 At the Add Users and Groups dialog box, select your local machine from the List 
Names From drop-down menu.

5 Select the Administrators group in the Names list and click Add.

6 At the Type of Access field, select Allow Access. Click OK twice to return to the 
Distributed COM Configuration Properties dialog box.

To Assign Launch Permissions to the Local Administrators Group:

1 Select the Default Security tab. Under Default Launch Permissions click the Edit Default 
button. 

2 In the Registry Value Permissions dialog box click Add.

3 At the Add Users and Groups dialog box, select your local machine from the List 
Names From drop-down menu.

4 Select the Administrators group in the Names list and click Add.

5 At the Type of Access field, select Allow Launch. Click OK twice to return to the 
Distributed COM Configuration Properties dialog box.

6 Close DCOM and restart your system.

Installing RequisiteWeb on the Server
Note:  For current RequisiteWeb users, be sure to remove any earlier version of 
RequisiteWeb prior to installing the current release of RequisiteWeb on your server. 
Do not remove your ReqWeb virtual directory; instead, redirect it to the components 
in your new RequisiteWeb installation. Refer to Uninstalling RequisiteWeb on page 53 
for specific instructions. Be sure to retain your existing catalog.txt file. You must also 
reset your DCOM configuration settings for Word Document and, if it exists, Word 
Basic to their default values.

Note:  To install RequisiteWeb, you must have a Rational license key. You can acquire 
and import the Rational license keys before or after installing Rational RequisitePro. If 
you install RequisiteWeb as part of a Rational Suite, you must select the appropriate 
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Suite license usage order. In the Rational License Administrator, click Settings > 
License Usage Mapper. See Prioritizing Licenses on Your System (License Usage Mapper) in 
the Administering Licenses for Rational Software manual.

1 Log on to the RequisiteWeb Windows server as a local administrator.

2 Insert the Rational Solutions for Windows CD disc 1 into your system’s CD drive. 
The setup program starts automatically. If autorun is disabled on your system, 
click Start  >  Run. Using the drive letter of your CD-ROM drive, type 
<drive:>\SETUP.EXE, where <drive:> is the drive letter of your CD-ROM 
drive. The Rational Software Setup wizard guides you through the software 
installation.

3  On each screen, click the Next button to proceed to the next screen. The Rational 
Software Setup program writes a log of the installation activities. The log file is 
located, by default, in C:\Program Files\Rational\RSSetup\RSSetup.log

4 At the Choose Product screen, select Rational RequisitePro under the Product list.

5 At the Select Configuration screen, click Custom. 

Note:  If your database server is running on an international operating system, be 
sure that the install path does not include folders with double-byte character 
names.

6 At the Choose Features screen, select the Web Server Components check box.

7 Select or clear the following optional check boxes:

❑ Leave the RequisitePro check box selected.

❑ Leave the Rational Synchronizer check box unmarked. 

❑ The Sample Projects option, under the expanded RequisitePro options, allows 
you to include the RequisitePro Learning Project and QuarterByte Bank 
example projects. These projects are helpful for testing and learning 
RequisiteWeb.

❑ The Oracle Setup and SQL Server Setup options are required for database 
administrators who are configuring Oracle or SQL Server databases for 
RequisitePro projects.

Reboot Required

If files that are required for the installation are in use during the installation 
procedure, the Rational Windows Setup program may require that you reboot your 
system to complete the installation.

After rebooting, log on as the same user to complete the installation procedure.
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To complete your RequisiteWeb install, you must have a Rational license key. You can 
acquire and import the Rational license keys before or after installing Rational 
RequisitePro. If you install RequisiteWeb as part of a Rational Suite, you must select 
the appropriate Suite license usage order. In the Rational License Administrator, click 
Settings > License Usage Mapper. See Prioritizing Licenses on Your System (License Usage 
Mapper) in the Administering Licenses for Rational Software manual.

Note:  If you do not install your Rational product in the default C:\ directory 
you must edit your wrapper.properties file as follows:

In your Windows Explorer, navigate to the directory where you installed your 
Rational products. Locate \Rational\jakarta-tomcat\bin. Using a text editor, 
open the wrapper.properties file and check that java_home and 
tomcat_home paths reflect your installation directory.
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Configuring the Web Server Components 

This section presents procedures for installing and configuring Web Server 
components on a Windows IIS Server. Be sure to log on as an administrator before you 
begin the installation process.

This section contains the following procedures:

1 Configuring the Tomcat Servlet Engine

2 Testing Tomcat

3 Creating a ReqWeb Virtual Directory on IIS

4 Creating a Jakarta Virtual Directory on IIS

5 Adding a JSP Filter

Note:  The instructions in this document assume that you are installing Windows 
applications on your C:\ drive. Substitute the appropriate drive, if necessary, when 
performing all procedures.

Configuring the Tomcat Servlet Engine 

To configure Tomcat on your Windows IIS server:

1 Open an MS_DOS shell and navigate to the following directory:

C:\Program Files\Rational\Jakarta-tomcat\bin

2 Within this directory type the following:

tomcat_svc

3 Close the MS_DOS shell.
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4 Run Tomcat as a service and make the RqTomcat service start automatically during 
the system start up by completing one of the following sets of procedures 
depending on your system: 

Note:  If you receive an error message while attempting to run the Tomcat service, 
refer to Troubleshooting on page 55.

Testing Tomcat 

To verify that Tomcat is installed and configured correctly, open a browser on your 
RequisiteWeb Windows server and enter the following URL address: 
http://localhost:8080/servlet/SnoopServlet

Note:  The URL is case sensitive.

Snoop Servlet is a Tomcat web page that displays information about your Tomcat 
installation. The words “Snoop Servlet” should appear at the top of the displayed web 
page. If they do not, check the steps for installing Tomcat, above; or, refer to 
Troubleshooting on page 55.

Step Windows NT Windows 2000

1 Go to Start > Settings > Control 
Panel > Services.

Go to Start > Settings > Control Panel > 
Administrative Tools > Services.

2 Locate the RqTomcat service and 
double-click on the icon to display 
the Properties dialog box.

Locate the RqTomcat service and 
double-click on the icon to display the 
Properties dialog box.

3 Select Automatic under Startup 
type.

On the General tab select Automatic in the 
Startup type drop-down menu.

4 Under Log On As select This 
account.

Select the Log On tab and then select This 
account.

5 In the This account and Password
dialog boxes type the name and 
password of the domain and the 
domain user that is used for 
RequisitePro                                                    
(e.g. "Domain"\ReqWebUser).
Note: You must replace the 
"Domain" entry with the correct 
RequisiteWeb domain. Click OK.

In the This account and Password dialog 
boxes type the name and password of the 
domain and the domain user that is used for 
RequisitePro                                                         
(e.g. "Domain"\ReqWebUser).
Note: You must replace the "Domain" entry 
with the correct RequisiteWeb domain.

6 In the services window click the Start 
button.

On the General tab under Service status click 
the Start button.

7 Click Close to finish. Click OK to finish.
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Creating a ReqWeb Virtual Directory on IIS

To create a virtual directory for RequisiteWeb on your RequisiteWeb Requirements 
server:

1 Launch the Internet Service Manager by doing one of the following:

❑ In Windows NT 4.0, click Start > Programs > Windows NT 4.0 Option Pack > Microsoft 
Internet Information Server > Internet Service Manager.

❑ In Windows 2000 Server, click Start > Programs > Administrative Tools/Internet 
Services Manager.

2 Right-click the Default Web Site and select New Virtual Directory.

3 In the Virtual Directory Creation Wizard, click Next and type an Alias: ReqWeb.

4 Click Next and browse to and select 
C:\Program Files\Rational\jakarta-tomcat\webapps\ReqWeb

5 Click Next and make sure that only the Read and Run options are checked if using 
Windows 2000 and that only the Read and Script options are checked if using 
Windows NT.

6  Click Next and Finish to complete the wizard.

Creating a Jakarta Virtual Directory on IIS 

To configure a virtual directory for Jakarta Tomcat on your RequisiteWeb server:

1 Launch the Internet Services Manager by doing one of the following:

❑ In Windows NT 4.0, click Start > Programs > Windows NT 4.0 Option Pack > Microsoft 
Internet Information Server > Internet Service Manager.

❑ In Windows 2000 Server, click Start > Programs > Administrative Tools/Internet 
Services Manager.

2 Right-click the Default Web Site and select New > Virtual Directory.

3 In the Virtual Directory Creation Wizard, click Next and type an Alias: jakarta.

Note:  The alias, jakarta, must be lower-case.

4 Click Next and browse to and select 
C:\Program Files\Rational\jakarta-tomcat\jakarta

5 Click Next and make sure that only the Read, Run, and Execute options are checked if 
using Windows 2000 and that only the Read, Script, and Execute options are checked 
if using Windows NT.
Configuring the Web Server Components 47



6 Click Next and Finish to complete the wizard. Leave the Internet Services Manager 
open.

Adding a JSP Filter 

The following filter setting instructs IIS to process JSP pages using Tomcat.

1 Right-click on the Default Web Site and select Properties.

2 At the ISAPI Filters tab, click Add.

3 Type the filter name: jakarta

Note:  The filter name, jakarta, must be lower-case.

4 Browse to and select 
C:\Program Files\Rational\Jakarta-Tomcat\jakarta\isapi_redirect.dll

Note:  You may not be able to see the isapi_redirect.dll file. If not, type 
isapi_redirect.dll in the File name box. 

5 Click OK to close the dialog boxes.

Note:  To test your JSP filter, right-click on the Default Web Site, select Properties 
and click the ISAPI Filters tab. A green up-arrow should appear next to jakarta 
under the Status column.

6 Leave the Internet Services Manager open.

Table 9 ReqWeb Virtual Directory Configuration in IIS

Step Windows NT 4.0/IIS 4.0 Windows 2000 Server/IIS 5.0

1 Right-click the ReqWeb virtual directory 
(located under the Default Web Site) and 
select Properties. 

Right-click the ReqWeb virtual directory 
(located under the Default Web Site) and 
select Properties. 

2 At the Properties dialog box, click the 
Virtual Directory tab.

Select Read permission; clear Write 
permission.

Be sure that the Application Settings section 
contains the Name “ReqWeb”.

Clear the box Run in separate memory space.

At the Permissions list, select Script.

At the Properties dialog box, click the 
Virtual Directory tab.

Select Read permission; clear Write 
permission.

Clear the Directory Browsing check box.

Be sure that the Application Settings section 
contains the Application Name “ReqWeb”.

Accept Medium Application Protection.
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3 Click Configuration.

At the Application Configuration dialog 
box, click the App Options tab.

Select Enable session state.

Set ASP Script timeout to at least 90 seconds. 

Keep default values for all other settings. 
Click OK.

Click Configuration.

At the Application Configuration dialog 
box, click the App Options tab.

Select Enable session state and set Session 
timeout to 20 minutes.

Set ASP Script timeout to at least 90 seconds.

Keep default values for all other settings. 
Click OK.

4 At the Properties dialog box, click the 
Directory Security tab.

In Anonymous Access and Authentication 
Control, click Edit.

At the Properties dialog box, click the 
Directory Security tab.

In Anonymous access and authentication 
control, click Edit.

5 At the Authentication Methods dialog box, 
select Allow Anonymous Access, clear all 
other check boxes and click Edit.

At the Authentication Methods dialog box, 
select Anonymous Access, clear all other 
check boxes and click Edit.

6 In the Anonymous User Account dialog 
box, at Username field, replace the default 
entry by typing: 
“Domain”\ReqWebUser, and type a 
password of your choice.

Clear the check box Enable Automatic 
Password Synchronization. Click OK twice.

In the Anonymous User Account dialog 
box, at Username field, replace the default 
entry by typing: 
“Domain”\ReqWebUser, and type a 
password of your choice. 

Clear the check box Allow IIS to control 
password. Click OK twice.

Table 9 ReqWeb Virtual Directory Configuration in IIS
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Testing RequisiteWeb

To test a RequisitePro project in RequisiteWeb:

1 Open your browser.

2 Set the URL address to the full path to the logon page in the RequisiteWeb virtual 
directory; for example: http://<server name>/reqweb

Note:  Be sure to use the server name rather than an IP address.

3 Navigate to that address. The RequisiteWeb log on page appears.

4 Select a RequisitePro project that contains documents from the Project list. If your 
project does not appear on the list, refer to the procedure Managing RequisitePro 
Projects for RequisiteWeb on page 51.

5 Type your RequisitePro User name and Password and click Log On.

6 Click the Documents icon, select a document and open it. Once the document opens 
RequisiteWeb has been properly installed.   

Note:  If the Microsoft Word installer appears, you must allow it to complete.

7 At the Properties dialog box, click the 
Documents tab. 

Select the Enable Default Document check 
box. Click Add.

At the Add Default Document dialog box, 
type index.html. Click OK.

At the Properties dialog box, on the 
Documents tab, select the index.html 
entry in the default document list. Use the 
up arrow to move that entry to the top of 
the list.

Click OK.

Note: If you are using SSL skip step 8.

At the Properties dialog box, click the 
Documents tab. 

Select the Enable Default Document check 
box. Click Add.

At the Add Default Document dialog box, 
type index.html. Click OK.

At the Properties dialog box, on the 
Documents tab, select the index.html 
entry in the default document list. Use the 
up arrow to move that entry to the top of 
the list.

Click OK.

Note: If you are using SSL skip step 8.

8 At the Properties dialog box, click the HTTP 
Headers tab.

Check Enable Content Expiration and select 
Expire Immediately.

Click OK. 

At the Properties dialog box, click the HTTP 
Headers tab.

Check Enable Content Expiration and select 
Expire Immediately.

Click OK. 

9 Close the Internet Service Manager Close the Internet Services Manager.

Table 9 ReqWeb Virtual Directory Configuration in IIS
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Final Steps

To finish configuring your RequisiteWeb installation, refer to the following sections:

� Managing RequisitePro Projects for RequisiteWeb on page 51

� Configuring E-mail for Discussions on page 52

� Uninstalling RequisiteWeb on page 53 

Managing RequisitePro Projects for RequisiteWeb

While RequisiteWeb provides features for accessing and editing requirements and 
documents in projects, you must use the full RequisitePro PC client application to 
create projects and documents. RequisitePro offers project templates and other 
management tools for creating and modifying project structure and security. For more 
information refer to the guide Using Rational RequisitePro or the RequisitePro online 
help.

Using the RequisiteWeb Project Catalog 

RequisiteWeb uses a catalog text file to provide access to RequisitePro projects. By 
default, the file contains entries for the RequisitePro Learning Project and another 
sample project. The projects that are listed in your catalog file appear in the Projects 
drop-down list on the RequisiteWeb logon page.

To add your own projects to the catalog, you must enter the full path for the project 
file, which has a .rqs extension. For instructions on modifying the catalog, see Editing 
the RequisitePro Projects Catalog on page 52.

Accessing Projects on Different Servers 

By default, local projects are created in the following directory: 
C:\Program Files\Rational\RequisitePro\ReqWeb\Projects

RequisiteWeb can open SQL Server- and Oracle-based projects that are not physically 
located on the RequisiteWeb server; however, in this case the ReqWebUser domain 
user must have Change or Modify permission for the directory containing the 
RequisitePro (.rqs) project file on the remote project server.

In order to access RequisitePro projects that are stored in an Oracle database, you 
must configure Oracle client software on the server. Refer to the sections Setting Up 
PCs for Oracle Access on page 23. That section refers to a RequisitePro installation on a 
client PC; you must perform that procedure on the RequisiteWeb server. 
Final Steps 51



Important: You must install the Oracle client software before installing the JDK if you 
are using a version of Oracle that is earlier than 8.1.7.

Editing the RequisitePro Projects Catalog 

To edit the catalog, perform the following procedure on the RequisiteWeb server:

1 Navigate to the directory: 
C:\Program Files\Rational\RequisitePro\ReqWeb\Projects

2 Using a text editor, open the catalog.txt file. 

3 Create an entry on each line with the full path to the RequisitePro project file. Copy 
the format of default project entries. 

Note:  Use a full path for local projects on the Requirements server. To access 
projects on another server, you must specify a Universal Naming Convention 
(UNC) path to the shared folder containing the RequisitePro .rqs file. 

4 Save and close the catalog.txt file.

Note:  In order to view updates to the catalog.txt file, users must log off RequisiteWeb 
and then select a project at the RequisiteWeb project “log on” page.

Configuring E-mail for Discussions

To configure e-mail for RequisitePro discussions, refer to Configuring E-mail for 
Discussions on page 12 in this guide. You use the same Rational E-mail Reader session 
for both RequisitePro and RequisiteWeb; however, note the following requirements 
when configuring the Rational E-mail Reader for both RequisitePro and 
RequisiteWeb: 

� You must run the Rational E-mail Reader on a different server than the 
RequisiteWeb server.

� In order to enable e-mail for RequisiteWeb discussions, you must configure 
discussion e-mail using the SMTP protocol option in the Rational E-mail Reader. 
The MAPI protocol option is not supported for RequisitePro or RequisiteWeb.

� The E-mail Setup option on the RequisitePro Tools menu does not configure e-mail 
for RequisiteWeb discussions. Use the Rational E-mail Reader, as described  on 
page 12, to configure e-mail for RequisiteWeb discussions.
52 Chapter 4 - Installing and Configuring Rational RequisiteWeb



Uninstalling RequisiteWeb

This section describes how to remove RequisiteWeb from a RequisiteWeb server. Prior 
to removing RequisiteWeb from your system, make sure that no one is using 
RequisiteWeb or any associated files. You will not be able to remove files that are in 
use.

RequisiteWeb installs a new project catalog containing paths to new sample projects. 
Be sure to make a copy of your existing catalog.txt file before removing RequisiteWeb. 
If you are upgrading from an earlier release of RequisiteWeb, the catalog.txt file 
should be located in the following default directory: C:\Inetpub\wwwroot\reqweb

Add your previous catalog.txt entries to the new catalog file that is installed with the 
new version of RequisiteWeb in the default directory: 
C:\Program Files\Rational\RequisitePro\ReqWeb\Projects

For more information, see Managing RequisitePro Projects for RequisiteWeb on page 51.

Removing RequisiteWeb 

To remove RequisiteWeb from a Windows NT or Windows 2000 server, you must 
have Windows administrator privileges on that machine. Use the following 
instructions to:
� Remove or redirect the ReqWeb virtual directory
� Stop the IIS Admin Service
� Remove the RequisiteWeb program files
� Restart your Web Publishing Service

Removing or Redirecting the ReqWeb Virtual Directory

1 Launch the Internet Services Manager by doing one of the following:

❑ Click Start > Run, and type inetmgr. Click OK.

❑ In Windows NT 4.0, click Start > Programs > Windows NT 4.0 Option Pack > Microsoft 
Internet Information Server > Internet Service Manager.

❑ In Windows 2000 Server, click Start > Programs > Administrative Tools/Internet 
Services Manager.

2 Select the Default Web Site and click the Stop button on the toolbar.

3 Right-click on the ReqWeb virtual directory and select Properties. The ReqWeb 
Properties dialog box appears. Click the Virtual Directory tab.

4 Depending on whether you are upgrading or simply removing RequisiteWeb from 
your system, do one of the following:
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❑ If you are upgrading to a new version of RequisiteWeb, do not delete your 
ReqWeb virtual directory. After you have installed your new version of 
RequisiteWeb, you will redirect the ReqWeb virtual directory to the new path, 
described in Creating a ReqWeb Virtual Directory on IIS on page 47.

❑ If you are not upgrading, but simply removing all RequisiteWeb components 
from your system, click Remove and click OK to close the dialog box.

Stopping the IIS Admin Service

Perform the instructions in the following table. Refer to the column that corresponds 
to your operating system.

Removing the RequisiteWeb Program

Use the Add/Remove Programs function in the Windows Control Panel to select and 
remove RequisitePro. After the uninstall process is complete, check to see if the 
C:\Program Files\Rational\RequisitePro\ReqWeb directory is still present on the 
server. If so, delete the ReqWeb directory and its subdirectories. 

Step Windows NT 4.0 Windows 2000 Advanced Server

1 Close the Internet Service Manager. In the Internet Services Manager, 
right-click on the server name.

2 At the Start/Run command line, type 
cmd. 

Select Restart IIS.

3 In the MS-DOS window, type the 
following:
net stop iisadmin /y 
and press Enter. 

At the Stop/Start/Reboot dialog box, 
select Stop Internet Services on <server 
name>.

4 The following message appears: “The 
IIS Admin Service was stopped 
successfully.” The C:\ prompt 
appears after the command is 
successfully executed. Type exit to close 
the MS-DOS window.

Click OK to close the dialog box.

Close the Internet Services Manager.
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Restarting the Web Publishing Service

Perform the instructions in the following table. Refer to the column that corresponds 
to your operating system.

Troubleshooting

Tomcat

If you receive an error message while attempting to run the Tomcat service, right-click 
on My Computer and choose properties. In the System Properties dialog box select the 
Advanced tab and choose Environment Variables. Check the following values under 
System variables:

1 java_home

This should point to the jre installed with your Rational product. By default the 
location is C:\Program Files\Rational\common\java\jre1.2.2

2 tomcat_home

This should point to the Tomcat installed with your Rational product. By 
default the location is C:\Program Files\Rational\jakarta-tomcat

3 path

This should include the java executable installed with your Rational product. 
By default the location is C:\Program 
Files\Rational\common\java\jre1.2.2\bin

Step Windows NT 4.0 Windows 2000 Advanced Server

1 In the MS-DOS window, type the 
following: 
net start w3svc 
and press Enter.

In the Internet Services Manager, 
right-click on your server name.

2 The following message appears: “The 
World Wide Web Publishing Service was 
started successfully.” The C:\ prompt 
appears after the command is 
successfully executed.

Select Restart IIS. 

At the Stop/Start/Reboot dialog box, 
select Restart Internet Services on <server 
name>.

3  Type exit to close the MS-DOS window. Click OK to close the dialog box and close 
the Internet Services Manager.
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4 In your Windows Explorer navigate to C:\Program 
Files\Rational\jakarta-tomcat\bin. Using a text editor, open the 
wrapper.properties file and check your java_home and tomcat_home paths.
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5Troubleshooting
If you have any problems running the Rational Software Setup program, try the 
following suggestions before you call Rational Customer Support for help:

� Be sure to stop all applications before you begin the installation.

� Turn off all virus protection software. These programs often run in the background 
and interfere with the installation and file decompression process.

� Turn off any user interface managers or desktop environments that run on top of 
Microsoft Windows.

� Change to a standard VGA video driver while Rational Setup is running, or 
disable video features such as virtual screens or screen switching.

� Change to a standard mouse driver, or disable special mouse features that perform 
tasks such as leaving pointer trails or changing pointer sizes.

� Make certain that your system meets the minimum system requirements listed in: 
“System and Software Requirements” on page 2 and 
“RequisiteWeb System Requirements” on page 38.

Installation Messages

Contact Rational Customer Support for information and assistance regarding any 
error messages you encounter while installing Rational software. See “Contacting 
Rational Technical Support” on page xiv contact information.
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Installation error messages, including messages for silent installations, are displayed 
in the file <Install Path>\RSSetup\Error.log. For more information on silent 
installations, refer to the guide Installing Rational Suite, which is included on the CD: 
Rational Solutions for Windows – Online Documentation CD.

Support Information

Contact Rational Customer Support if you have questions regarding the installation, 
use, or maintenance of this Rational Software product.

Contacting Rational Technical Support on page xiv provides Rational Customer Support 
telephone and e-mail contact information.

Table 10 Silent Installation Messages

Message Description

Product “ProductName” specified in 
response file is not contained in the 
product list.

This error message appears when the 
response.ini file contains an 
invalid product name.

Unable to open response file. Typically, this error occurs when the 
installation procedure cannot locate 
the response.ini file. Either you 
have specified an incorrect path or 
the response.ini file is not in the 
default location. 

Information required to remove the 
specified product cannot be found. 
The product may not be removed 
automatically.

When trying to remove a product 
with the /uninstall switch, you 
either specified a product that is not 
installed on your system or you 
incorrectly typed the product name 
on the command line.

Confirm that you are specifying a 
product on your system. Confirm 
that you have typed the product 
name exactly as it appears in the 
Rational Software Setup program.
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